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Quantum Vue
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Main Dashboard

The six tiles in the center of the Main Dashboard screen allow you to:
•	 View system-wide energy information.
•	 Remain aware of system-wide alerts.
•	 Manage scheduled events.
•	 Access the Quick Controls screen.
•	 Access the Load Shed screen.
•	 Access the Occupancy screen.
The Navigation drop-down menu, located in the left-hand corner of the menu bar, allows you to navigate to other 
areas.
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Main Dashboard (continued)

The icon , located in the right-hand corner of the menu bar, allows you to view and customize various project 
wide and administrative settings.
This menu is accessible from any screen.
•	 All Alerts: pg. 5
•	 Manage Users: pg. 17
•	 Project Settings: pg. 18
•	 Help – Provides contact information to get help with the software
•	 Manage Area Groups: pg. 25 
•	 System Activity: pg. 21
•	 Sign Out – Logs out the currently signed in user
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Energy

Select the Energy tile from either the Main Dashboard or the Area Dashboard to open the Energy detail screen. 
The interactive screen provides energy-usage and power-consumption data for the entire system (if navigating 
from the Main Dashboard) or for a selected area (if navigating from the Area Dashboard).
•	 Select the viewing time frame: Click on or touch the drop-down menu located in the upper left-hand section of 

the detail screen to choose a data-viewing time span; press the left/right arrow buttons, located on either side 
of the pull‑down menu, to view previous months and toggle back to the current time period.

•	 View a savings analysis for the selected time frame based on energy saving strategies being employed: Click 
on or touch the Savings By Strategy button located in the upper left-hand section of the detail screen.

•	 Export data to a .CSV file format: Click on or touch the Export icon located in the upper right-hand section of 
the detail screen.

•	 Generate and save custom reports: Click on or touch the Advanced Reports link located in the upper 
right‑hand section of the detail screen to create and save customized reports which compare multiple areas, 
cover custom time ranges, and measure different types of data. Note: The Advanced Reports link is also an 
access point for custom reports that you’ve previously created and saved.
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Alerts

Select the Alerts tile from either the Main Dashboard or the Area Dashboard to open the Alerts detail screen. This 
interactive screen provides a list of all current/open alerts in the system (if navigating from the Main Dashboard) or 
only in the current area (if navigating from the Area Dashboard).
•	 Filter the list of alerts: Click on or touch the All Alert Types drop-down menu located in the upper left-hand 

section of the detail screen.
	 If alerts occur while you are using the Quantum Vue software, you will receive a badge alert notification at the 

top of the screen regardless of the screen you are viewing. For extra coverage, configure the Quantum system 
to notify you of selected alerts via email; this feature is currently available from the Q-Admin software.
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Alerts Email

The Email tab under the Project Settings dashboard is where the user can set up SMTP mail server settings. This 
allows the system to email alerts to users who are subscribed to receive them (see pg. 4).

•	 Fill in the SMTP server name, Port #, Sender email, and display name.
•	 If your Mail server requires SSL encryption check the box.
•	 If your Mail server requires authentication check the box, and fill in the Username and Password.

Once you fill out all the information, you can send a test email to verify settings.



Quantum 3.2 Software User Manual    7
®

Schedules: Overview

Select the Schedules tile from either the Main Dashboard or the Area Dashboard to view a calendar of scheduled 
events. All schedules and events in the system will be shown if you navigate from the Main Dashboard; schedules 
and events that affect only the selected area will be shown if you navigate from an Area Dashboard.
A schedule (timeclock) is simply a group of one or more events.
•	 View all events in all schedules: Select the All Timeclocks option from the Schedule drop-down menu located 

in the upper left-hand section of the detail screen.
•	 View events for a single schedule: Select the desired timeclock from the Schedule drop-down menu.
•	 Add a new schedule: Select Add Timeclock from the Schedule drop-down menu.
•	 Navigate through the calendar: Toggle the left/right arrow buttons on either side of the date range located in the 

upper middle section of the detail screen.
•	 Add a new event: Click on or touch the Add Event link located in the upper right-hand section of the detail 

screen.
•	 Edit an existing event: Click on or touch the desired event in the calendar; in the pop-up window, select 

Occurrence or Series.
–	 Click on or touch Occurrence: On the resulting screen, click on or touch the pencil icon to change 

occurrence settings and timing. Note: Editing an event occurrence causes that event to be set apart as an 
event separate from the series

	 or
–	 Click on or touch Series: On the resulting screen, click on or touch the pencil icon to change series settings 

and timing; disable, delete, copy the series; test the series behavior.
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Schedules: Add Schedule

Select Add Timeclock from the Schedule drop-down menu located in the upper left‑hand section of the  
detail screen.
•	 Add a new schedule: Enter the name of the new schedule in the Name field of the pop-up window.
•	 Allow Catchup: Controls whether events will be applied when the system starts back up in the event of a 

power failure.
–	 Click on or touch Catchup box to check: events in the schedule will be executed in order if they were 

missed during a power failure condition
	 or
–	 Click on or touch Catchup box to uncheck: the system will not retroactively execute missed events when it 

returns from a power failure condition.
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Schedules: Add Event

Select the Add Event link located in the upper right‑hand section of the calendar to open an interactive screen.
•	 Create and program a new scheduled event:

1.	 Specify the new event in the Event Name field.
2.	 Select the schedule which you would like the new event to be a part from the Inside Timeclock drop-down 

menu.
3.	 Determine When the event will occur. Events can occur:

–	 At fixed times (e.g., 7:30 AM)
	 or
–	 Relative to astronomic conditions (e.g., 30 minutes before sunrise)

4.	 Specify the recurrence conditions for an event; select a:
–	 Weekly pattern
	 or
–	 Series pattern By Dates

·	 Create an event that only runs only one time: Click on or touch the By Dates button, enter the 
specific date for the event, deselect the Repeat Annually checkbox

	 or
·	 Specify the start and end dates (by default, recurring events start on the earliest available day and 

repeat indefinitely): Click on or touch the By Dates button, enter the specific date for the event, keep 
the Repeat Annually checkbox selected. If there are dates in the recurrence on which you do not 
want the event to run, click on or touch the Add Exception link and specify these dates.

5.	 Determine the behavior for the event (the actions that will take place in the system when the event occurs). 
Refer to the Schedules: Specify Event Behavior—Location section.

6.	 When you have set all of the event parameters as desired, click on or touch the Save button to commit the 
changes to the system.
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Schedules: Specify Event Behavior—Location

Select the Add Event link located in the upper right‑hand section of the calendar to open an interactive screen.
•	 To specify an event’s behavior, perform the following steps in order:

1.	 Click on or touch the Add Location link to generate a dialog box.
2.	 Select one or more areas that will be affected by the action(s) you will set.

–	 Use the < Back and > links to navigate between the areas in the system.
–	 Each area that you have selected will be identified with a check mark.

3.	 When you have finished selecting areas, click on or touch the Done button.
4.	 Proceed to the Schedules: Specify Event Behavior—Action section.
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Schedules: Specify Event Behavior—Action

•	 When all desired locations have been set, specify the actions for each location:
1.	 Click on or touch the + Add Action link next to each location in turn.
2.	 In the resulting dialog box, use the Showing drop-down menu to select an item.
3.	 When an item is selected, the possible actions will appear below it; add a check mark to each action that 

you want to apply.
4.	 Specify the value that you want to apply for the check-marked action (for example, if viewing Lighting 

Scenes, the action that can be performed is a Scene activation. Placing a check mark in the Scene action 
box enables you to select the scene that you want to activate).

	 You can select more than one type of action for a given location (e.g., you can select a lighting scene and 
adjust the occupied level).

5.	 When you have finished specifying actions for a location, click on or touch the Done button.
6.	 Repeat Steps 1–5 for each location.

	 Note: To specify actions for all of the locations in your event (instead of setting actions for each location, one at 
a time, as described above), proceed to the Schedules: Specify Event Behavior—Edit All section.
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Schedules: Specify Event Behavior—Edit All

To program multiple locations to perform the same action(s) when an event occurs:
1.	 Click on or touch the Edit All pencil icon.
2.	 In the resulting dialog box, specify one or more actions for all of the selected locations. Note: The behavior of 

this dialog box is similar to the + Add Action dialog box featured in the Schedules: Specify Event Behavior—
Action section.

	 If the desired action is already specified for a selected location, the existing value will be changed to whatever 
you have specified in the Edit All dialog box; if the desired action is not already specified, it will be added.
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Schedules: Edit Event

The screen generated by clicking on the event is similar to the one featured in the Schedules: Specify Event 
Behavior—Add Event section; there are three main event sections: Name and schedule, Timing, Behavior.
•	 Edit an event: Click on or touch the event in the main calendar. If the event is a recurring event, you will be 

prompted to:
–	 Edit the entire recurring series
	 or
–	 Edit only the particular occurrence you selected, in which case the event will be set apart as an event 

separate from the recurring series.
•	 Modify a section: Click on or touch the pencil icon. Follow the same procedure described in the Schedules: 

Specify Event Behavior—Add Event section. Click on or touch the Save button to commit your edits to the 
system.

•	 Disable an event: Click on or touch the Disable button located in the upper right-hand section of the detail 
screen.

•	 Delete an event: Click on or touch the Delete button located in the upper right-hand section of the detail 
screen.

•	 Copy an event:
1.	 Click on or touch the Copy button located in the upper right-hand section of the detail screen to generate a 

browser tab with a new event that is an exact copy of the previous event.
2.	 Change the name of the new event; event names within a given schedule must be unique.
3.	 Edit the new event as desired before saving it.

•	 Test an event: Click on or touch the Test button located in the upper right-hand section of the detail screen. 
Note: To ensure that the behavior is working as programmed, the event’s actions will be executed when you 
click on or touch this button!
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Quick Controls 

Quick Controls allows the user to group several actions to be activated at one time.
1.	 Click + Add New in the upper left corner.
2.	 Create a name for the control.
3.	 Click on + Add Location.
•	 You can select the whole building or click the arrow on the right to select a floor or to select an area.
•	 When you have selected the area(s) you wish to control, click Done.
•	 Click + Add Action 
	 – �From the Affect drop-down you can choose the device type you want to control.
	 – �Once done selecting all the actions for that area, click Done.
•	 If you wish to change the location or action click the blue pencil icon on the right of the location you wish to 

edit.
	 – �From the pop-up menu you can Edit Location, Edit Action, or Delete.
4.	 When you are done adding locations and actions hit Save in the lower right corner.
5.	 To edit or delete an already saved quick control click Edit next to its name.
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Load Shed

Load shedding allows the building manager to monitor whole building lighting power usage and apply a load shed 
reduction to selected areas, thereby reducing a building’s peak power usage. Load shedding can be configured 
individually for each selected area in the system at levels between 0% and 90%. 0% is the same as no load 
shedding. 

Change load shedding targets for areas 
1. Choose an area using the Area by area adjustment.
2. Select the Affect box to load shed the area, or deselect it to prevent the area from being affected. 
3. Type a number (from 0 to 90) in the Goal column. This is the percentage of the lighting level by which you want 

to reduce the area (0% = no reduction; 90% = maximum reduction). 
4. Repeat for other areas for which you want to change load shedding. 
5. Click Save. 

Enable/disable load shedding 
1. Click the slide button next to Load Shed Disabled to enable load shedding for the entire project (a 

confirmation will appear stating “Enabling load shed will save any changes below and begin lowering lights 
immediately”). The text next to the slide button will change to Load Shed Enabled. 

2. Click the slide button next to Load Shed Enabled to disable load shedding for the entire project The text next 
to the slide button will change to Load Shed Disabled. 

Typing a new number in the Set target demand text box changes the demand goal (red line). This represents a 
reference line for the building manager. To reduce demand when building power usage gets close to or above the 
line, adjust the load shedding to higher percentages for selected areas.  
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Occupancy

The Occupancy page allows the user to monitor the usage of areas based on the amount of time the areas are 
occupied. By monitoring the occupancy of area’s the user can see if an area is being utilized to its fullest extent. 
There are two main views you can choose Whole System and By Area. Whole System will give an average 
occupied percentage based off of working hours and for the entire day. By Area gives the percent time occupied 
for each area during working hours only.
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Manage Users

The Manage User Dashboard allows for the creation of users for the Quantum Vue software with different 
permissions. 
•	 Click on a user under Select a user to edit user info or edit alert subscriptions.
•	 Click on + Add User in the upper right corner to create an account or use an intranet account.
•	 Click on Create an account to add a user.
	 1.	 Fill in Username, Email, and Role.
	 2.	 �If you check Subscribe to alert notifications, choose the types of notifications you want that user to 

receive from the drop-down menu next to it.
	 3.	 �On the gray part of the screen in the upper left you can assign the whole building, or use the drop-down 

menu to select each floor to assign individual areas or whole floors.
	 4.	 �To assign an area, click on the area you want to assign. Blue highlighted areas are the ones selected for 

that user.
	 5.	 Click Save in the lower right corner when complete.
•	 Click on User intranet account to add a user from a domain server.
	 1.	 Fill in Domain, Username, Email, and Role.
	 2.	� Selecting Subscribe to alert notifications allows you to choose the types of notifications you want that 

user to receive from the drop-down menu next to it.
	 3.	 �On the gray part of the screen in the upper left you can assign the whole building, or use the drop-down 

menu to select each floor to assign individual areas or whole floors.
	 4.	 �To assign an area, click on the area you want to assign. Blue highlighted areas are the ones selected for 

that user.
	 5.	 Click Save in the lower right corner when complete. 
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Project Settings

Project settings is where you can change global settings for your system.  Some of these settings are used for 
calculations so the more accurate they are entered the more accurate the calculations will be.
•	 Alerts – You can choose what system events will email you alerts when they occur.
•	 �Energy – �You can set the sq ft for each area which is used to calculate energy per sq ft in the energy report 

screen.
•	 �Hyperion – �You can change how long Hyperion will be disabled when a shade is controlled manually, adjust 

the start/end time of Hyperion as well as where the shades will move to.
•	 �Working Hours – �You set the working hours for your building, this information is used when calculation space 

utilization.
•	 Email – This is where you set your mail server settings so the system is able to send out email alerts.
•	 Language & Units – you can change the Language displayed as well as units of measurements.
•	 Change Background – allows you to add a custom background image.
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Change Quantum Vue Background

Users can change the background image in Vue from this page. There are two choices included, the default city 
skyline and the gray background, you can also choose the custom option to upload an image of your liking. The 
image size used is 2048 x 1536, using an image of a different size could cause the image to be distorted.  

To upload a custom image click on the Upload a custom image link, select 
the image file you want to use as your background and click Open.  
Once the file is uploaded click Save in the lower right.
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Lamp Hours

Quantum systems have a feature that will warn a user when the lamps in their fixtures are nearing the 
manufactures expected life. When a lamp is replaced the user can enter in the expected life for the lamp or if it is 
the same as the previous lamp they can reset the counter.

From the Project Settings page you can configure the lamp hours settings 
by clicking the check box by Lamp nearing end of life then clicking 
Configure.

Click on the Global Lamp Life Settings link in the upper left of the 
screen to access the Global settings. In this window you can set the 
expected life of each type of fixture, plus when the system will notify you 
when they are reaching end of life.
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System Activity Report

The System Activity Report lets the user select and view historical data on how the system is performing and 
being used. There are 15 different activity types you can choose from. You can also choose area to view the 
selected activities, and the time that you want the latest reported activity to show.

There are 15 different Activities that you can select.
Lights – �Shows when light levels are changed.
Shades – �Shows when a shade or shade group changes level either by direct user control or Hyperion.
Occupancy / After Hours – Shows when an area becomes occupied or unoccupied.
Device Control – Shows when a button has been pressed on a keypad or Pico remote.
Schedules – Lists when scheduled timeclock events have happened.
Alerts / Diagnostics – Displays any devices that are not responding to the system.
Daylighting – Shows when changes were made to Daylighting settings.
Tuning – Displays when changes have been made to High-End or Low-End trim.
Quick Controls – Shows whenever a Quick Control in Quantum Vue is activated.
Load Shed - Lists the light levels that areas went to when Load-Shed is enabled or disabled.
Partition Walls – Displays whenever there is a state change for partitioned walls.
Area Groups – Lists any changes that are made to an area group.
Sequences – Shows when a sequence starts or changes to a new step.
Variables – Shows when the state of a variable changes.
Users – Shows when a user logs in or logs out.
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Navigation

Select the Navigation drop-down menu in the left-hand corner of the menu bar to view a list of locations.
•	  Navigate to a specific location: Click on or touch any item in the list.
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Floorplan: Overview

After navigating to an area, you will see an interactive floorplan. To control the floorplan view:
•	 Pan: Click on or touch the screen and then drag.
•	 Zoom in and out: Scroll (or pinch with two fingers) or use the + and – buttons located in the upper right‑hand 

part of the detail screen. Note: Most floorplan areas will be labeled, but some labels may not be visible until you 
zoom in.

To change screen viewing options, select the Showing drop-down menu located in the upper right-hand section 
of the detail screen.
•	 Examine different views of the floorplan: Toggle between Lights, Energy, and Occupancy.
•	 Enable or disable Alert indicators in any floorplan view.
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Fixtures on the Floorplan

You can now view the status and control the individual fixtures in an area on the floorplan view. This features allows 
the user to adjust the light level for specific fixtures, before you only had control over the whole area or individual 
zones which could contain multiple fixtures. 

From the Fixture Control pop-up you can adjust 
maximum light level by clicking the blue link at the 
bottom of the pop-up. A new pop-up will appear where 
you can enter the maximum value that fixture will be 
able to achieve. (Ex. If you set the value to 75% when 
you would raise the slider to 100% or hit the full on 
button the lights will only go to 75%)

When you click on the  icon the Fixture Control pop-up will appear. From this 
pop-up you can adjust the slider to raise and lower the light level for the fixture you 
clicked. You can also click on the d button to turn the light full on or g button to turn 
the light off.
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Manage Area Groups

Navigating to the Manage Area Groups window menu
1.	 In the upper right window select the  menu button.
2.	 In drop-down menu select Manage Area Groups.
3.	 Select an area group to view its members using the drop-down on the top left corner.
4.	 Gray hotspots represent areas not assigned to an area group, light blue hotspots represent areas assigned to 

other area groups, and dark blue hotspots represent areas assigned to the currently selected area group.

Creating a new area group
1.	 In the upper left window, click the drop-down menu to select the floorplan into which you wish to group areas.
2.	 In the upper left window, click the drop-down menu named Select an area group.
3.	 Click the + Add New button in drop-down menu to create a new area group.
4.	 Uniquely name the new area group category, then click the Done button.
5.	 Click on areas to add them to the area group category. You can navigate between different floorplans to select 

other hotspots. The hotspot will turn dark blue when assigned to the area group. Click the hotspot a second 
time to remove it from the area group. The hotspot will turn gray when unassigned from the area group. Areas 
cannot be assigned to more than one area group.

6.	 Click on the Save button in the bottom right corner of the floorplan to save the new area group.

Editing an area group’s name
1.	 Navigate to the Manage area groups window.
2.	 In the upper left window, click the drop-down menu named Select an area group.
3.	 Click the Edit button to rename area groups.
4.	 Uniquely rename desired area groups.
5.	 Click Done to save new area group names.
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Editing area group hotspots
1.	 Navigate to the Manage area groups window.
2.	 In the upper left window, click the drop-down menu named Select area group.
3.	 In the drop-down menu select the area group to edit.
4.	 Click gray colored hotspots to add them to the area group.
5.	 Click dark blue colored hotspots to remove them from the area group.
6.	 Click on the Save button in the bottom right corner of the floorplan to save the new area group.

Deleting area groups
1.	 In the upper left window, click the drop-down menu named Select an area group.
2.	 Click the Edit button.
3.	 Click the red delete icon next to the area group to be deleted.
4.	 Click the red Delete button to confirm the deletion of the area group.
5.	 Click Done to exit from area group editing.

Adjusting scene levels for an area group
1.	 Navigate to the area dashboard for an area within the area group that you want to edit.
2.	 Open the Lights tile to observe area zones and scenes.
3.	 Edit zone levels to desired levels.
4.	 Click the Save to a scene button.
5.	 Choose a scene in the drop-down menu to save the new levels.
6.	 To save the scene to the entire area group, select the area group in the For drop-down menu.
Notes: The area must already be assigned to an area group to apply changes to the area group. 
Scene editing an area group (multiple areas) is only allowed for areas having a single zone. If an area group has 
areas containing both single and multiple zones, changes will only be applied to areas with a single zone. Areas 
with multiple zones will not have the new scene levels saved.
7.	 Click the Save button to save changes.

Occupancy changes with area groups
1.	 Navigate to the area dashboard for an area within the area group that you want to edit.
2.	 Open the Occupancy tile to observe area occupancy settings.
3.	 Edit the desired occupancy settings.
4.	 To apply new settings to the area’s area group, select the area group name from Apply the settings above the 

drop-down menu. You can also apply settings to All areas in the system if desired.
	 Note: The area must already be assigned to an area group to apply changes to the area group.
5.	 Click the Save button to save changes.

High-End / Low-End tuning using area groups
1.	 Navigate to the area dashboard for an area within the area group that you want to edit.
2.	 Open the Tuning tile to observe high- and low-end trim settings.
3.	 Edit the high-end and/or low-end trim percentages to desired levels.
4.	 To apply new settings to the area’s area group, select the area group name from the Apply the settings above 

to drop-down menu. You can also apply settings to All areas in the system if desired.
Note: The area must already be assigned to an area group to apply changes to the area group.
 

Manage Area Groups (continued)
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Partitioning

Partitioning allows two or more area’s to behave as one area or as independent area’s based on the open/closed 
status of the partitioned walls.

From the area pop-up you can click the Walls button to join or separate multiple 
rooms. The image to the left shows that SW Conference Room B is currently joined 
with SW Conference Room A. To separate these rooms press the Separate button.

The image to the left shows that SW Conference Room B is currently separated from 
SW Conference Room A. To join these rooms press the Join button.
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Area Dashboard 

Click on or touch an area on the floorplan to activate an area pop-up menu. Use this menu to:
•	 Control lighting and/or shades: Toggle lights on or off; toggle shade group buttons to open or close; click on  

or touch the arrow buttons to adjust levels in the selected area.
•	 Edit the area name: Click on or touch the pencil icon next to the area’s name; enter a new area name in the 

resulting field.
•	 View additional information and settings for the selected area: Click on the Area Dashboard link in the  

pop-up menu.



Quantum 3.2 Software User Manual    29
®

Area Dashboard (continued)

The Area Dashboard provides at-a-glance information about any selected area and, with interaction, allows you 
to view additional details and make adjustments to any feature.
•	 Click on or touch a tile to navigate to the detail screen for that feature.
•	 Adjust desired settings in the selected detail screen.
The link to return to the floorplan is located in the upper left-hand section of the screen.
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Energy

Select the Energy tile from either the Main Dashboard or the Area Dashboard to open the Energy detail screen. 
The interactive screen provides energy-usage and power-consumption data for the entire system (if navigating 
from the Main Dashboard) or for a selected area (if navigating from the Area Dashboard).
•	 Select the viewing time frame: Click on or touch the drop-down menu located in the upper left-hand section of 

the detail screen to choose a data-viewing time span; press the left/right arrow buttons, located on either side 
of the pull‑down menu, to view previous months and toggle back to the current time period.

•	 View a savings analysis for the selected time frame based on energy saving strategies being employed: Click 
on or touch the Savings By Strategy button located in the upper left-hand section of the detail screen.

•	 Export data to a .CSV file format: Click on or touch the Export icon located in the upper right-hand section of 
the detail screen.

•	 Generate and save custom reports: Click on or touch the Advanced Reports link located in the upper 
right‑hand section of the detail screen to create and save customized reports which compare multiple areas, 
cover custom time ranges, and measure different types of data. Note: The Advanced Reports link is also an 
access point for custom reports that you’ve previously created and saved.
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Alerts

Select the Alerts tile from either the Main Dashboard or the Area Dashboard to open the Alerts detail screen. This 
interactive screen provides a list of all current/open alerts in the system (if navigating from the Main Dashboard) or 
only in the current area (if navigating from the Area Dashboard).
•	 Filter the list of alerts: Click on or touch the All Alert Types drop-down menu located in the upper left-hand 

section of the detail screen.
	 If alerts occur while you are using the Quantum Vue software, you will receive a badge alert notification at the 

top of the screen regardless of the screen you are viewing. For extra coverage, configure the Quantum system 
to notify you of selected alerts via email; this feature is currently available from the Q-Admin software.
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Schedules: Overview

Select the Schedules tile from either the Main Dashboard or the Area Dashboard to view a calendar of scheduled 
events. All schedules and events in the system will be shown if you navigate from the Main Dashboard; schedules 
and events that affect only the selected area will be shown if you navigate from an Area Dashboard.
A schedule (timeclock) is simply a group of one or more events.
•	 View all events in all schedules: Select the All Timeclocks option from the Schedule drop-down menu located 

in the upper left-hand section of the detail screen.
•	 View events for a single schedule: Select the desired timeclock from the Schedule drop-down menu.
•	 Add a new schedule: Select Add Timeclock from the Schedule drop-down menu.
•	 Navigate through the calendar: Toggle the left/right arrow buttons on either side of the date range located in the 

upper middle section of the detail screen.
•	 Add a new event: Click on or touch the Add Event link located in the upper right-hand section of the detail 

screen.
•	 Edit an existing event: Click on or touch the desired event in the calendar; in the pop-up window, select 

Occurrence or Series.
–	 Click on or touch Occurrence: On the resulting screen, click on or touch the pencil icon to change 

occurrence settings and timing. Note: Editing an event occurrence causes that event to be set apart as an 
event separate from the series

	 or
–	 Click on or touch Series: On the resulting screen, click on or touch the pencil icon to change series settings 

and timing; disable, delete, copy the series; test the series behavior.
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Lights: Basic

Select the Lights tile from the Area Dashboard to open the Lights detail screen for the current area. The 
interactive screen provides a list of area scenes on the left and a series of zone control sliders in the center.
•	 Activate a scene: Click on or touch the corresponding button in the list on the left. The lighting zones in the 

area will adjust their levels to achieve the desired scene.
•	 Edit scene or zone names: Click on or touch the Rename link located in the lower left-hand corner of the detail 

screen; enter a new scene name in the resulting field.
•	 Raise or lower all of the lighting zones in the area at once: Press the raise/lower arrow buttons located below 

the scene buttons.
•	 Raise or lower individual lighting zones separately: Click on or touch the slider or switch control and change the 

levels for the desired zone; adjust the level of each lighting zone until the desired light levels are achieved. Note: 
Because the lighting zones will actually change their levels in the space, it’s best to perform this action while 
standing in the physical space so that the exact desired lighting levels can be achieved.

•	 Save new zone levels to a scene:
1.	 When desired levels are achieved, click on or touch the Save To link located in the lower right-hand section 

of the detail screen.
2.	 Choose the scene to which you would like to save the current zone levels.

To make more advanced changes to scenes, click on or touch the Advanced link located in the lower left-hand 
section of the detail screen.
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Lights: Advanced

The Lights: Advanced detail screen allows you to further define the behavior of each lighting scene.
•	 Set the levels of each lighting zone for a given scene: Enter a level into the % field for each zone.
•	 Specify the fade and delay times that will apply for each zone when the scene is activated: Select the Fade 

and Delay drop‑down menus to assign times for each zone.
•	 Deselect one or more zones: Uncheck the desired Include check-boxes. Note: Zones that are not included in 

a given scene will not be affected when that scene is activated.
To return to the Lights: Basic detail screen, click on or touch the Hide Advanced link located in the lower 
left‑hand section of the detail screen.
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Shades

Select the Shades tile from the Area Dashboard to open the Shades detail screen for the current area. The 
interactive screen provides an inventory of the shade groups across the top.
•	 Select a preset for each shade group: Select the corresponding button on the left-hand side of the shade 

image.
•	 Set the level for each shade group:

–	 Press the raise/lower arrow buttons located below the preset buttons
	 or
–	 Enter a shade position into the % field under the shade image
	 or
–	 Drag the shade image itself to the desired level.

•	 Identify a shade group in the area (e.g., when there is more than one shade group and the names are not 
descriptive enough):
1.	 Select the Identify link below the shade group that you want to identify: That shade group in the physical 

space will raise and lower several times.
2.	 Select the Identify link again (the link will read Stop while the shade group is identifying): The shade group 

will stop moving.
3.	 Select the Rename link and enter in a more descriptive name for the shade group. Note: The Rename link 

can also be used to rename the shade group presets.
•	 Edit any shade group preset:

1.	 Set the desired level for the shade group using one of the methods specified above.
2.	 Select the Save To link of the selected shade group.
3.	 Choose the preset to which you would like to save the current shade level.
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Hyperion 

The Hyperion system allows for the automatic control of shades based on the astronomical position of the sun in 
relation to the building. The shades will automatically adjust position throughout the day as the sun moves to allow 
optimal sunlight into the area.
1.	 Navigate to an area’s Dashboard which contain shades.
2.	 Click the Shades tile to open area shade properties.
3.	 Enable and disable the Hyperion using the Enabled/Disabled slider at the bottom.
	 a. �When disabling the Hyperion, you must choose whether to disable Hyperion indefinitely or until  

the end of day.
4.	 Click on the Adjust Hyperion Settings link at the bottom of the page.
5.	 �Adjust Manual Override, Hyperion Schedule, Architectural Hyperion, and Work Environment settings  

for the area.
6.	 Click Save or Cancel when finished.
7.	 Click the View History link at the bottom right of the page.
8.	 View the area’s shade level history.
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Hyperion Settings

The Hyperion settings page allows a user to configure Hyperion settings for a specific area, rather than using 
project-wide settings.
Area Settings
•	 �Manual Override Settings: Adjust how long the Hyperion software is disabled when an occupant moves  

the shades.
•	 �Hyperion Schedule: Adjust when the Hyperion Schedule will start and end automatic movement  

of the shades.
•	 �Architectural Hyperion: Adjust between moving the shades to preset levels or moving to any level.
•	 Work Environment: Adjust the room configuration settings.
Shade Group Settings
•	 Current sensor reading: Displays the current fc value of the light level sensor.
•	 Brightness override: Adjust the light level value for a very bright instance and how the shades will react.
•	 Dark override: Adjust the light level value for a very dark instance and how the shades will react.
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Hyperion Adjustment Wizard

The Hyperion Adjustment Wizard analyzes the history of your automated shades to recommend changes that will 
improve Hyperion performance for that space. You pick one of the three options that best describe what you are 
seeing, which shade group experienced the problem (if have multiple shade groups and are unsure which one is 
the one you want you can click identify next to the name and that shade group will move up and down) and when 
did the problem occur, then click View Recommendations. You can receive multiple suggestions you can click i  
to open a pop-up that will give an explanation for that recommendation.  
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Hyperion Report

The Shade History Report displays how the Hyperion software has been operating to automatically control the 
shades to minimize glare and provide optimal shading performance.
•	 Select a Shade group in order to view historical data.
	 – Use the Shade group drop-down at the top left part of the screen.
•	 Select the time frame for which you want to review historical data.
	 – Use the selection control at the top right part of the screen to select a 24-hour view or an Hourly view.
	 – �Use the controls at the top center part of the screen to select the 24-hour or Hourly period that you want  

to view.
•	 �Using the check boxes at the bottom of the screen, select which items you would like to appear in the 

graph.  You can choose to display the shade level, the reason for shade movements, various Hyperion setting 
thresholds, the Hyperion mode, and the window sensor reading.

Using this data, you can see how the shades move in response to the current sensor value and the specified 
Hyperion threshold settings.
Note that the sensor reading may be the reading from a single sensor, or it may be an average of values taken 
from more than one sensor, depending on how the Hyperion settings have been configured.
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Daylighting

The Daylighting screen allows you to change how an area’s lights will respond to the daylight sensors. The slider 
allows you to determine how aggressively the lights dim in response to the natural daylight entering the space. You 
can disable daylighting from affecting the lights in this area with the slide button in the upper left
Ex. �If you want the lights to be very dim when there is a lot of natural light coming in you move the slider to 

decrease brightness.

If you have multiple rows of lights that are affected by daylighting you 
can click on the Advanced Link. By doing this you can adjust how 
much each row is affected by the daylight sensor. Usually rows closer 
to the window receive more daylight and can dim down more than the 
rows farther from the window.
You can also set a brightness level target, this is the amount of light the 
system will maintain in an area when the daylighting feature is active. 
When there is no daylight present, the lights will be at this level, when 
there is daylight present, the lights will dim down to achieve this level.
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Daylighting History

Clicking View History from the Daylighting screen will take you to the Daylighting History screen. This chart will 
show the fc reading of each sensor in the area if there are multiple sensors you can see the average of the sensors 
as well as each sensor. You can also compare your daylight sensor readings with your energy consumed for that 
area to see how daylighting is lowering energy consumption. You can export the data from this chart by click on 
the  in the upper right corner.
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Tuning: High-End Trim

Select the Tuning tile on the Area Dashboard to view and adjust the high-end trim of the lights in the currently 
selected area.
•	 Adjust all lights: Enter a new value in the All Lights % field or press the raise/lower arrow buttons located 

below the field.
•	 Adjust individual lighting zones in the area: Click on or touch the Advanced link located in the lower left-hand 

section of the detail screen. High-end trim levels for each zone will be shown to the right of the All Lights 
adjustment controls. Adjust the high-end trim of each zone independently, as desired.

•	 Click on or touch the Save button to commit your changes to the system.
Note: In certain rare cases, a zone may have a high-end trim that cannot be adjusted because of advanced 
settings configured in the Q-Design software; this may happen when individual fixtures within the zone have 
different high-end trim levels.
•	 To apply new settings to the area’s area group, select the area group name from the Apply the settings above 

to drop-down menu. You can optionally apply settings to All areas which is a default system wide area group. 
Note: The area must already be assigned to an area group to apply changes to the area group.
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Tuning: Low-End Trim

Select the Tuning tile on the Area Dashboard to view and adjust the low-end trim of the lights in the currently 
selected area. 
•	 Click Adjust Minimum Light Levels to expand the controls to adjust low-end trim. 
•	 Adjust all lights: Enter a new value in the All Lights % field or press the raise/lower arrow buttons located 

below the field. 
•	 Adjust individual lighting zones in the area: Enter a new value for each individual lights % field or press the 

raise / lower arrow buttons located below each field.
•	 Click on or touch the Save button to commit your changes to the system. 
•	 To apply new settings to the area’s area group, select the area group name from the Apply the settings above to 

drop-down menu. You can optionally apply settings to All areas which is a default system wide area group.
	 Note: The area must already be assigned to an area group to apply changes to the area group.
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Occupancy: Sensors

Select the Occupancy tile on the Area Dashboard to view and adjust the occupancy settings for the selected 
area. If occupancy sensors are in use for the selected area, you will see a screen similar to the one pictured above.
•	 Enable or disable occupancy processing for the current area: Toggle the Occupancy enable/disable control 

located in the upper left-hand section of the detail screen. If occupancy is disabled, the sensor(s) in the area will 
not turn the lights on or off when occupancy or vacancy is detected.

•	 Adjust the occupancy control behavior for the area: Click on or touch the Sensor Mode drop-down menu to 
select desired function.
–	 Auto-On/Auto-Off: lights will be controlled when occupancy is detected and when vacancy is detected.
–	 Auto-Off Only: lights will be controlled only when vacancy is detected—lights will need to be manually 

turned on when persons enter the room.
•	 Add an additional timeout value to the sensor(s) in the area. This timeout is the time interval that the system 

will wait after detecting vacancy and before sending the lights to the unoccupied level. Note: This value is in 
addition to the timeout that is set locally on the sensor(s) themselves (most occupancy sensors have a timeout 
dial or control button on the rear portion of the sensor; this parameter cannot be controlled from the system 
and must be adjusted manually).

•	 Specify the occupied and unoccupied light levels or lighting scenes that will be activated by the system when 
occupancy or vacancy, respectively, are detected in the area.

•	 To apply new settings to the area’s area group, select the area group name from the Apply the settings above 
to drop-down menu. You can optionally apply settings to All areas which is a default system wide area group. 
Note: The area must already be assigned to an area group to apply changes to the area group.
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Occupancy: After Hours

After Hours manages light levels during non-work/non-business hours in areas that are not controlled by 
occupancy sensors.
Just before After Hours begins, the system initiates the Blink Warn Timeout—flashes the lights in the area—to 
alert occupants that the lights will be going to a low, After Hours light level (generally off).
After the Blink Warn Timeout, the system will turn the lights to the After Hours level.
If an occupant uses a wall control at any time, either during the Blink Warn period or after the lights have been 
sent to the After Hours level, the system will wait for a longer timeout period — “After Hours timeout” — before 
again flashing the lights and preparing to send the lights to the After Hours level.
•	 Select the After Hours tile on the Area Dashboard to view and adjust the After Hours settings for the selected 

area. The After Hours tile will be present only for areas that have been configured to use After Hours in the 
Q-Design software.

•	 Enable or disable After Hours behavior in the current area: Toggle the After Hours enable/disable control 
located in the upper left-hand section of the detail screen.

•	 Adjust the After Hours settings: Use the drop-down menus on the screen.
Note: To specify the times at which After Hours begins and ends for the current area, create events to start and 
end after-hours with the Schedules feature.
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Occupancy

The Occupancy page allows the user to monitor the usage of areas based on the amount of time the areas are 
occupied. By monitoring the occupancy of areas the user can see if an area is being utilized to its fullest extent. 
There are two main views you can choose: Whole System and By Area. Whole System will give an average 
occupied percentage based off of working hours and for the entire day. By Area gives the percent time occupied 
for each area during working hours only.
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Keypad Lock/Unlock

A user can lock a keypad from a Quantum Vue system, so a button press on that keypad will not perform the 
action assigned to it.  

Click on the Devices tile from the area dashboard. This will take you to the Devices 
page where you will have the option to lock/unlock individual keypads or all keypads.

When you are on the Devices page, you move the slider to lock 
individual keypads or hit the “Lock all” link to lock all keypads in that 
area.
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Variables

The Variables screen will show all variables that are being used in the system. Variables are used in the lighting 
system to change the operation of the system based on the state of the variable. You can manually change the 
state of the variable from this screen.
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Ballast Replacement

Select the Ballast/Drivers tile on the Area Dashboard. If a ballast/driver fails on a DBI or ECO loop, you are able 
to address a replacement ballast/driver from this screen.  
Note: If only one ballast/driver has failed on a loop, then auto-replacement will work automatically when the 
ballast/driver is replaced in the space. This feature is only for multiple ballast/driver replacements.
•	 Replace the failed ballast/driver with an unaddressed ballast.
•	 Click on the Start Activation Process button.
•	 If the area contains more than one link of ballasts/drivers, you will be able to flash both links to help identify and 

select the link that contains the ballast you are trying to replace.
•	 A loading screen will appear, then, after a few minutes, a message will appear asking if the ballast/driver you 

would like to activate is flashing.
•	 If the light connected to the ballast/driver that was replaced is flashing click Yes. Otherwise click ‘No, Flash 

Next’, until the correct ballast is flashing. Click Yes.
•	 Additional steps may be required to flash and select the appropriate zone, flash and select the appropriate 

daylighting row, and flash and select the appropriate fixture type to which the ballast is assigned. These steps 
may be necessary to properly identify the driver.

•	 A Confirm ballast/driver assignment screen will appear showing where the ballast/driver is assigned.  
Click Close.

•	 If there are more unaddressed ballasts to activate, you can continue addressing ballasts/drivers in the same 
manner or click Save to exit addressing mode and save the current state.

•	 If all unaddressed ballasts are replaced, a message will appear stating that all ballasts/drivers have been found 
and are ready for activation. Click Save Changes to finalize the assignment.
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Q-Admin
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Diagnostics: Check Status

Diagnostics allows the building manager to check the status of all equipment in the lighting control system. 

View Diagnostics
Devices will be listed with a reporting status of OK, missing, not in database, or unknown. Check or uncheck the 
filters above the grid (OK, Unknown, Not in Database, Not Responding) to show or hide devices with those 
states. At any time, click the Show Report link above the grid to show the same information in a report form; this 
report can be saved, exported to .xls or .csv formats, and printed. 

View which devices are currently not responding
1.	 Make sure the Not Responding checkbox at the top of the screen is checked. All other checkboxes can be 

unchecked to filter the list to only non-responding devices.
2.	 �Use the diagnostics tree to navigate to which devices are currently not responding, or click Expand All to show 

all devices.
3.	 To generate a report that can be printed or saved, click on Show Report.
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Reports: Open a Report

Open a Report
Open a saved report
1.	 Click Open in the Reports tab.
2.	 Click the selected report.
3.	 Click OK. The report will be loaded in a new subtab under the View tab.
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Reports: Save, Print, and Export a Report

Save, Print, and Export a Report
Reports can be printed and saved. Exporting to Excel format (.xls) requires Microsoft® Excel® 2003 or newer to be 
installed; alternatively, reports may be exported in .csv format. All reports can be exported in tabular format (to .xls 
or .csv). Only reports that have a graphical view can be exported to the .jpg image format.

Save a report that has been created
1.	 Click Save or Save As…
2.	 If saving for the first time (or choosing Save As…), you will be prompted for the report name. Change the 

default name, if desired, and click Save.

Print a report
1.	 Click Print.
2.	 Select the desired printer, choose options, if desired, and click OK.

Save a report to a file
1.	 Click Export.
2.	 Select the desired output format (.xls, .jpg, or .csv).
3.	 Choose the output file name by typing in the text box and/or using the Browse… button.
4.	 Afterwards, to open the file in the default spreadsheet or image application, check Open File after Export.
5.	 Click Export.

 

Microsoft and Excel are registered trademarks of Microsoft Corporation in the United States and/or other countries.
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Reports: Options

Report Options
Reports can be run with different options (e.g., the report above can be run for one or more areas over a specified 
time period).

Choose areas displayed in a report
1.	 Click Click here to select Areas…
2.	 Check one or more areas in the area tree.
3.	 Click OK.
To change other options in reports, use the appropriate controls on the right-hand panel. Available options vary by 
report.
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Reports: Lighting Energy Usage Report

Lighting Energy Usage Report — “How much energy did the lighting in [selected areas] use over [time period]?”
This report shows a pie chart comparing multiple areas over a period of time. It can be used to find which areas 
are using the most energy.

Create a Lighting Energy Usage Report
1.	 Select the areas to compare by using the Click here to select Areas… link.
2.	 Choose the time frame by using the drop-down menu on the right.
3.	 Click Apply.
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Reports: Lighting Power Usage Report

Lighting Power Usage Report — “How does the power usage of [selected areas] compare over [time period]?”
This report shows a bar graph comparing multiple areas’ energy usage over a period of time.

Create a Lighting Power Usage Report
1.	 Select the areas to compare by using the Click here to select Areas… link.
2.	 Choose the time frame by using the drop-down menu on the right.
3.	 Click Apply.
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Reports: Lighting Power Trend Comparison Report

Lighting Power Trend Comparison Report — “How does the power usage of [selected area] compare over 
[selected time frames]?”
This report shows power usage for a particular area over two different time spans. For example, this can be used 
to compare this week’s energy usage with that of last week.

Create a Lighting Power Trend Comparison Report
1.	 Select the area by using the drop-down menu on the right.
2.	 Choose the first date by using the Time Frame A Start Date drop-down menu.
3.	 Choose the second date by using the Time Frame B Start Date drop-down menu.
4.	 Select the time span in the Duration drop-down menu.
5.	 Click Apply.
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Reports: Lamp Maintenance Report

Lamp Maintenance Report — “Which Areas are reporting failed lamps?”
This report, run against a specified area, lists the number of failed lamps in that area or, if it is a folder area, the 
number of failed lamps in each of its child areas. Areas with no failures are not displayed.

Create a Lamp Maintenance Report
1.	 Select an area in the drop-down menu.
2.	 Click Apply.
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Reports: System Activity Report

System Activity Report — “What activity occurred in [selected areas] over [time period]?”
This report gives a list of activity that has happened in the Quantum system (or in specified areas) over a given 
period of time. The report will display all events of the specified types that happened in the specified areas within 
the specified date range. Activity filters are as follows:
•	 Occupant Activity: Areas going occupied/unoccupied; wall controls being pressed.
•	 Time Clock Activity: Time Clock events being executed.
•	 Building Manager Activity: Q-Admin activity, including login/logout, and real-time changes to the lighting 

system.
•	 Status Activity: Zone level changes, area scene changes, etc.
•	 Device Failure Activity: Devices becoming unresponsive.
•	 Lamp Failure Activity: Lamp failures reported by EcoSystem/DALI ballasts.
•	 Sensor Activity: Occupancy sensor state changes (occupied and unoccupied).
•	 Ballast Failure/Auto Replacement Activity: When ballast failures have occurred or when new ballasts have been 

installed and auto-replaced.
•	 System Errors: Error codes reported by the system.
•	 BACnet Activity: Lights, shades, and other system objects changed through BACnet.

Create a System Activity Report
1.	 Select one or more areas by using the Click here to select Areas… link.
2.	 Choose the time span for which to display activity by using the over the… drop-down menu. If selecting 

Custom, specify the start date and end date.
3.	 Select the desired activity types to show by clicking the checkboxes under Filter Events.
4.	 Click Apply.
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Reports: Diagnostics Report

Diagnostics Report — “What devices are currently not responding and need attention?”
The Diagnostics Report displays the same information found in the Diagnostics screen. Devices (e.g., keypads, 
shades, power panels) are listed with their current statuses (unknown, not responding, not in database, or OK).

Create a Diagnostics Report
1.	 Select one or more areas by using the Click here to select Areas… link.
2.	 Select the desired status types to show by clicking the checkboxes under Show devices with status…
3.	 Click Apply.
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Reports: Sensor Connection Report

Sensor Connection Report — “What sensors are not properly connected?”
This report shows the status of wired sensors (occupancy, IR, and photo), as unknown, not connected, not in 
database, or connected.

Create a Sensor Connection Report
1.	 Select one or more areas by using the Click here to select Areas… link.
2.	 Select the desired status types to show by clicking the checkboxes under Show Sensor whose Status is…
3.	 Click Apply.
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Reports: DALI Emergency Units Report

DALI Emergency Units Report
The DALI Emergency Units Report allows the user to view, export, and print the status of DALI emergency units.

Create a DALI Emergency Units Report
1.	 Select one or more areas by choosing the Click here to select Areas… link.
2.	 Select the desired status types to show by clicking the checkboxes under Show devices with status…
3.	 Click Apply.
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Q-Design
Note: �Any changes made through Q-Design will affect the entire system. The procedures explained here should 

only be made by trained professionals or those very comfortable with maintaining their Quantum system. If 
you are not comfortable making these changes, please contact Lutron Field Service at 1-888-588-7661 or 
email at LSCScheduling@lutron.com.
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Database Back-up 

 

 

It is always recommended to back-up your current database before making any changes. This gives you a restore 
point in case you make changes you do not like or that negatively affects performance of your system.
To Back-up your current database
1.	 Open the Q-Design Shortcut in the Quantum system folder.
2.	 Click on File in the upper left corner
3.	 Select Open Current Q-Admin File (Depending on the size of your system this can take several minutes)
4.	 Once the Database is open click on File in the upper left corner
5.	 Click Save As
6.	 �It is recommended when creating a name to include the date and time of the back-up, this helps in finding the 

most recent back-up easier when you start having multiple copies.

If you are planning on making changes it is recommended that when you go to save the database with the 
changes to give it a new time when naming so you will have the original back-up as well as a copy with the 
changes you made. This will give you a restore point in case you do not like the changes made.
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continued on next page…

Sensor Replacement

To determine the database area to which your wireless device corresponds, open your most recent database.

Open the database file
1.	 Open the Q-Design Shortcut in the Quantum system folder.

a. If you receive the warning, “Either Q-Runtime or Q-Admin is already running on this machine. This application 
will be forced to run in offline mode,” you must first close LutronServiceManager before you can open 
Q-Design shortcut.

b.	 To close LutronServiceManager, locate it in your system tray (next to the system clock) and double‑click 
to open it. Once it’s open, use the keyboard shortcut Ctrl+Shift+F7 to close the program. When it’s closed, 
open Q-Design shortcut again.

2.	 Select File > Open Current Q-Admin File.
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Update the Serial Number
1.	 Go to Activate tab > QSM Sensors.
2.	 Use the drop-down menu to navigate to the area in which your QS Sensor Module (QSM) is located.
	 If you cannot locate the QSM or if you don’t know the area in which it is located in the database, search 

through all of the QSMs in the drop-down menu to locate the wireless device.
3.	 Select the QSM where your wireless device is connected. On the right-hand side you will see the devices and 

their serial numbers.
4.	 In the list, highlight the wireless device that you wish to replace. Double-click in the Serial # column and type in 

the serial number of the NEW device and click Enter.
5.	 On the left-hand side, click Start Activation and save the database if prompted.
	 We recommend against overwriting a previous database.
6.	 The NEW device will be activated automatically. Click Exit Activation.
7.	 For the changes to take effect, the database will need to be transferred:

a.	 Go to the Transfer tab.
b.	 Select the Processor System on the left-hand side.
c.	 Click Start Transfer.

Sensor Replacement (continued)
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QS Device Replacement	
To determine the database area to which your QS device corresponds, open your most recent database.
Open the database file
1.	 Open the Q-Design shortcut in the Quantum system folder.
	 a.	 �If you receive the warning, “Either Q-Runtime or Q-Admin is already running on this machine. This 

application will be forced to run in offline mode”, you must first close LutronServiceManager before you 
can open Q-Design.

	 b.	� To close LutronServiceManager, locate it in your system tray (next to the system clock) and double-click 
to open it. Once it’s open, use the keyboard shortcut Ctrl+Shift+F7 to close the program. When it’s closed, 
open Q-Design again.

2.	 Select File > Open Current Q-Admin File.
3.	 �Click on File > Save As, Give the file a new name. (This is done so you will have the old database to roll back 

to in case of any issues). 

Find the QS device you want to replace (Keypads)
1.	 Click on the View tab in the top left and select Switch to Classic View.
2.	 Click on the design tab and use the drop-down box to select controls.
3.	 �In the area tree on the left-hand side scroll down until you locate the area where the keypad is located that you 

want to replace.
4.	 �Click on the area where the keypad is located; all control devices for that area will appear in the box to the right 

of the area tree.
5.	 �Click on the keypad in the area you want to replace and mouse over the Assigned To link (write down the 

location that appears in a little pop-up window).

Activating QS device you want to replace (Keypads)
1.	 Click on the Activate tab and use the drop-down menu to select devices.
2.	 �Click the drop-down menu under Selected link, and click on the one that matched the last two parts of the 

Assigned To address from step 4.
3.	� In the activated Devices box, find the keypad you want to replace and change the serial number to match 

what is on the replacement keypad.
4.	 The NEW device will be activated automatically. Click Exit Activation.
5.	 �For the changes to take effect, the database will need to be transferred:* 
	 a.	 Go to the transfer tab.
	 b.	 Select the Processor System containing the replaced device on the left-hand side.
	 c.	 Click Start Transfer.
* �Note: during a transfer you will not have control of the system and lights will stay at the level they were at when 
the transfer was started. We recommend doing the transfer during after-hours when the building is mostly empty.

6.	 Once the transfer is complete, Save and Publish. 
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Open the database file
1.	 Open the Q-Design shortcut in the Quantum system folder.
	 a. �If you receive the warning, “Either Q-Runtime or Q-Admin is already running on this machine. This application 

will be forced to run in offline mode”, you must first close LutronServiceManager before you can open 
Q-Design.

	 b. �To close LutronServiceManager, locate it in your system tray (next to the system clock) and double-click 
to open it. Once it is open, use the keyboard shortcut Ctrl+Shift+F7 to close the program. When it is closed, 
open Q-Design again.

2.	 Select File > Open Current Q-Admin File.
3.	 �Click on File > Save As, Give the file a new name. (This is done so you will have the old database to roll back 

to in case of any issues). 

Activating a New Processor
1.	 Click on the activate tab.
2.	 �If your database has multiple subsystems, use the subsystem drop-down to select the subsystem that 

contains the processor you are replacing.
3.	 �If you are only replacing one processor, the new processor should show up in the display box on the left-hand 

side.
4.	 ��In the main display box, find the processor you are replacing. You can use the Customize columns link near the 

upper-right hand side to display the Serial # and MAC (Media Access Control) Address. Both the serial number 
and MAC address that you can view on the screen are printed on the processor itself, or on the label. 

Processor Replacement	
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Processor Replacement (continued)	

5.	 �Once you found the processor you want to replace, click the Deactivate link under the Action column for the 
row that relates to the old processor.
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6.	 �Click on the new processor that is displayed in the left-hand display box and click on the Activate link under 
the Action column for the row that relates to the new processor in the main display window.

Processor Replacement (continued)	
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Processor Replacement (continued)	

7.	 �The process may take several minutes after you click Activate. You will see “Updating” under the Status 
column. After the processor has been activated you will see the word Good and a check mark () in the 
Status column.

8.	 �When all processors on the subsystem in which you just replaced the processor show Good, click on the 
Tools option in the upper left corner, and select Update Processor Firmware.
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Processor Replacement (continued)	

9.	� An OS Upgrade window will appear showing all the subsystems in the database. Check the box that relates to 
the subsystem that contains the processor that was just replaced.

10.	�Click the Upgrade button that is in the lower left of the OS Upgrade pop-up window.
11.�	Upgrading the processor firmware can take several minutes to complete. During this upgrade do not cycle 

power to the processor.
12.�	When the processor is done upgrading, click Done.
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Processor Replacement (continued)	

13.	Click the transfer tab.
14.	On the left side of the screen under Transfer to System will be a list of all the subsystems in the database.
15.	�Check the box next to the subsystem that contains the processor that was replaced. Check the box below 

the subsystems that says Force Full Transfer. Under the Publish to Server area make sure that Publish 
Database is checked.

16.	�Click Transfer and Publish.
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17.	�A pop-up message will appear asking if you want to save the project first. Click Yes.

Processor Replacement (continued)	
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Processor Replacement (continued)	

18.	�Depending on how large the database is, the transfer could take several minutes.
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19.	�During the transfer an Audit Results pop-up window may appear. Review the list for errors. Click Ignore All if 
the errors are acceptable.

20.	Once the transfer has completed successfully the lighting system should be operating normally. 

Processor Replacement (continued)	
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Notes	
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Notes (continued)	
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Notes (continued)	
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Worldwide Technical and Sales Assistance
If you have questions concerning the installation or operation of this product,  
call Lutron Customer Assistance.
Please provide the exact model number when calling. Model number can be found on the product packaging. 
Example: QSE-IO

U.S.A., Canada, and the Caribbean: 1.844.LUTRON1 
Other countries call: +1.610.282.3800 
Fax: +1.610.282.1243
Visit us on the web at www.lutron.com/support

Lutron Electronics Co., Inc.  
7200 Suter Road 

Coopersburg, PA 18036 
USA

)Lutron, Lutron, Quantum, Quantum Vue, and Pico are trademarks of Lutron Electronics Co., 
Inc., registered in the U.S. and other countries. 

Q-Admin, Hyperion, and Q-Design are trademarks of Lutron Electronics Co., Inc. 

Microsoft and Excel are registered trademarks of Microsoft Corporation in the United States 
and/or other countries.
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